The Autodesk Revit World

*I’m sure you’ve seen* plenty of presentations on how wonderful and versatile this 3D Autodesk® Revit® Architecture revolution is. You may be thinking, “This all seems too complicated for what I do. Why do I need 3D anyway?”

The answer is: you don’t need 3D. What do you do to get a job out—that is, after the presentation when you’re awarded the project? First, you redraw the plans. Next comes the detail round-up game we have all come to love: pull the specs together and then plot. This is a simple process that works.

Well, it worked up until 3D showed up. Now we have no real clue where things come from, drawings don’t look very good, and getting a drawing out the door takes three times as long.

That’s the perception, anyway. I’ve certainly seen all of the above, but I’ve also seen some incredibly coordinated sets of drawings with almost textbook adherence to standards and graphics. Revit can go both ways—it depends on you to make it go the right way.

One other buzzword I’m sure you have heard about is *Building Information Modeling (BIM)*. Although they say BIM is a process, not an application, I don’t fully buy into that position. Right now, you are on the first page of BIM. BIM starts with Revit. If you understand Revit, you will understand Building Information Modeling.

This chapter will dive into the Revit Graphical User Interface (GUI) and tackle the three topics that make Revit...well, Revit.

In this chapter, you will learn about:

- The Revit architecture interface
- The Project Browser
- File types and families
The Revit Architecture Interface

Toto, we aren’t in CAD anymore!

If you just bought this book, then welcome to the Revit world. In Revit, the vast majority of the processes you encounter are in a flat 2D platform. Instead of drafting, you’re placing components into a model. Yes, these components have a so-called third dimension to them, but a logical methodology drives the process. If you need to see the model in 3D, it’s simply a click away. That being said, remember this: there is a big difference between 3D drafting and modeling.

With that preamble behind us, let’s get on with it.

First of all, Revit has no command prompt and no crosshairs. Stop! Don’t go away just yet. You’ll get used to it, I promise. Unlike most CAD applications, Revit is heavily pared down, so to speak. It’s this way for a reason. Revit was designed for architects and engineers. You don’t need every command that a mechanical engineer would need. An electrical engineer wouldn’t need the functionality that an architect would require. In the new Revit 2013 interface, the functionality I just mentioned is available, but it is tucked away so as not to interfere with your architectural pursuits.

**WARNING**  The preceding paragraph will be the longest one of the book. This book is designed to cut to the chase and show you how to use Revit Architecture in a step-by-step fashion without having to read through paragraph after paragraph just to find the answer you’re seeking. Datasets are provided on the book’s accompanying website (www.sybex.com/go/revit2013ner), but you can also use your own model as you go through the book. If you don’t wish to read this book cover to cover, don’t! Although I recommend going from front to back, you can use the book as a desk reference by jumping to a desired topic. The datasets will be added in phases to accommodate this type of usage. Either way, get ready to learn Revit!

You’ll find that, as you get comfortable with Revit, there are many, many choices and options behind each command.

Let’s get started:

1. To open Revit, click the icon on your desktop (see Figure 1.1), or choose Start ➾ All Programs ➾ Autodesk ➾ Autodesk Revit Architecture 2013 ➾ Autodesk Revit Architecture 2013 (see Figure 1.2).

**Figure 1.1**: You can launch Revit Architecture from the desktop icon.
FIGURE 1.2: You can also launch Revit Architecture using the Windows Start menu (this illustration shows the Windows 7 operating system).

2. After you start Revit, you will see the Recent Files window, as shown in Figure 1.3. The top row lists any projects on which you’ve been working; the bottom row lists any families with which you’ve been working.
The column to the right allows you to view some tutorial videos. If you have time, I recommend investigating this feature.

3. If you’re firing up Revit for the first time, you will see some sample projects, sample families, and a getting started video. On the left side of the Projects and the Families categories, you are provided with some choices on what type of project or family you would like to start (see Figure 1.4).

4. In the upper-left corner of the Revit window, you’ll see a big purple R. This is commonly known as the Application Icon. Click the purple R, and choose New ➔ Project.
5. The New Project dialog shown in Figure 1.5 opens. Click the Template File drop-down menu, and select Architectural Template. If you are a metric user, click the Browse button. This will open Windows Explorer. Go up one level, and choose the US Metric folder. Select the file called DefaultMetric.rte.

**Figure 1.5**: The New Project dialog allows you to start a new project using a preexisting template file, or you can create a new template file.

Now that the task of physically opening the application is out of the way, we can delve into Revit. Revit has a certain feel that Autodesk® AutoCAD® converts will need to grasp. At first, if you are already a CAD user, you’ll notice many differences between Revit and CAD. Some of these differences may be off-putting, while others will make you say, “I wish AutoCAD did that.” Either way, you’ll have to adjust to a new workflow.

**The Revit Workflow**

This new workflow may be easy for some to adopt, whereas others will find it excruciatingly foreign. (To be honest, I found the latter to be the case at first.) Either way, it’s a simple concept. You just need to slow down a bit from your AutoCAD habits.

Executing a command in Revit is a three-step process:

1. At the top of the Revit window is the Ribbon. A series of tabs is built into the Ribbon. Each tab contains a panel. This Ribbon will be your Revit launch pad! Speaking of launch pads, click the Wall button on the Architecture tab, as shown in Figure 1.6.
2. After you click the Wall button, notice that Revit adds a tab to the Ribbon with additional choices specific to the command you’re running, as shown in Figure 1.7. You may also notice that Revit places an additional Options bar below the Ribbon for even more choices.

3. After you make your choices from the Ribbon and the Options bar, you can place the object into the view window. This is the large drawing area that takes up two-thirds of the Revit interface. To place the wall, simply pick a point in the window and move your pointer in the direction that you want the wall to travel. The wall starts to form. Once you see that, you can press the Esc key to exit the command. (I just wanted to illustrate the behavior of Revit during a typical command.)

Using Revit isn’t always as easy as this, but just keep in mind this basic three-step process and you’ll be OK:

1. Start a command.

2. Choose an option from the temporary tab or the Options bar that appears.

3. Place the item in the view window.
Thus, on the surface Revit appears to offer a fraction of the choices and functionality that are offered by AutoCAD or any drafting program for that matter. This is true in a way. Revit does offer fewer choices to start a command, but the choices that Revit does offer are much more robust and powerful.

Revit keeps its functionality focused on designing and constructing buildings. Revit gets its robust performance from the dynamic capabilities of the application during the placement of the items and the functionality of the objects after you place them in the model. You know what they say: never judge a book by its cover—unless, of course, it’s the book you’re reading right now.

Let’s keep going with the main focus of the Revit interface: the Ribbon. You’ll be leaning on the Ribbon extensively within Revit.

### Using the Ribbon

You’ll use the Ribbon for the majority of the commands you execute in Revit. As you can see, you have little choice to do otherwise. However, this is good because it narrows your attention to what is right in front of you.

When you click an icon on the Ribbon, Revit will react to that icon with a new tab, giving you the specific additional commands and options you need. Revit also keeps the existing tabs that can help you in the current command, as shown in Figure 1.8. Again, the focus here is on keeping your eyes in one place.

![The Ribbon breakdown](image)

**Figure 1.8:** The Ribbon breakdown

In this book, I’ll throw quite a few new terms at you, but you’ll get familiar with them quickly. We just discussed the Ribbon, but mostly you’ll be directed to choose a tab within the Ribbon and to find a panel on that tab.

To keep the example familiar, when you select the Wall button, your instructions will read: “On the Build panel of the Architecture tab, click the Wall button.”
What's That Toolbar Above the Ribbon?

This toolbar is called the *Quick Access toolbar*. I’m sure you have seen a similar toolbar in other applications. It comes filled with some popular commands. If you want to add commands to this toolbar, simply right-click any icon and select Add To Quick Access Toolbar. To the left of this toolbar is the Revit Application button. Clicking this button gives you access to more Revit functions that will be covered later in the book. One great icon that I like to have docked on the Quick Access Toolbar is the Select Objects (or Modify) icon. I like to add this icon as shown in the following graphic.

![Right Click](image)

Now that you can see how the Ribbon and the tabs flow together, let’s look at another feature within the Ribbon panels that allows you to reach beyond the immediate Revit interface.

The Properties Interface

When you click the Wall button, a new set of commands appears. This new set of commands combines the basic Modify commands with a tab specific to your immediate process. In this case, that process is adding a wall.

You’ll also notice that the Properties dialog to the left of the screen will change. If you don’t see the Properties dialog as shown in Figure 1.9, click the Properties icon that is displayed in Figure 1.9. The Properties dialog shows a picture of the wall you’re about to place. If you click this picture, Revit will display all the walls that are available within the model. This display is called the Element Type menu (see Figure 1.10).
**Figure 1.9:** Click the Properties button to display the Properties dialog. Typically, the dialog is shown by default.

**Figure 1.10:** The Properties dialog gives you access to many variables associated with the item you’re adding to the model.
The objective of the next exercise is to start placing walls into the model:

1. Close Revit.
2. Reopen Revit, and start a new model (metric or Imperial).
3. On Build panel of the Architecture tab, click the Wall button.
4. In the Properties dialog, select Exterior - Brick and CMU on MTL. Stud from the Type Selector.

**Element Properties**

There are two different sets of properties in Revit: Instance Properties and Type Properties. Instance Properties will be available immediately in the Properties dialog when you place or select an item. If you make a change to an element property, the only items that are affected in the model are the items you’ve selected.

**The Properties Dialog**

As just mentioned, the Properties dialog will display the Instance Properties of the item you’ve selected. If no item is selected, this dialog will display the properties of the current view in which you happen to be.

In addition to accessing the Instance Properties, you can click the Edit Type button to open a dialog displaying the Type Properties of the selected item (see Figure 1.11). By making a modification here, you’ll change every occurrence of that item in the entire model.

Let’s take a closer look at the two categories of Element Properties in Revit.

**Instance Properties**

The items that you can edit immediately are called parameters, or Instance Properties. These parameters will change only the object being added to the model at this time. Also, if you select an item that has already been placed in the model, the parameters you see immediately in the Instance Properties dialog will change only that item you’ve selected. This makes sense—not all items are built equally in the real world. Figure 1.12 illustrates the Instance Properties of a typical wall.

**Type Properties**

The Type Properties (see Figure 1.13), when edited, will alter every item of that type in the entire model. To access the Type Properties, click the Edit Type button in the Properties dialog, as Figure 1.14 shows.
**Figure 1.11:** The Type Properties dialog gives you access to the parameters associated with the element you’ve selected.

**Figure 1.12:** The Instance Properties will change only the currently placed item or the currently selected item.
Figure 1.13: The Type Properties, when modified, will alter every occurrence of this specific wall in the entire model.

Figure 1.14: The Edit Type button allows you to access the Type Properties.
At this point, you have two choices. You can either make a new wall type (leaving this specific wall unmodified) by clicking the Duplicate button, or you can start editing the wall's Type Properties, as shown in Figure 1.15.

**Figure 1.15**: The Type Properties modify the wall system's global settings. Click the Preview button at the bottom of the dialog to see the image that is displayed.

**Warning**: I can’t stress enough that, if you start modifying Type Properties without duplicating the type, you need to do so in a very deliberate manner. You can easily affect the model in unintended ways. We'll discuss the specifics of all the wall’s Type Properties in Chapter 16, “Advanced Wall Topics.”

Now that you’ve gained experience with the Type Properties dialog, it’s time to go back and study the Options bar as it pertains to placing a wall:

1. Because we’re only exploring the Element Properties, click the Cancel button to return to the model.

2. Back in the Options bar, find the Location Line menu. Through this menu, you can set the wall justification. Select Finish Face: Exterior (see Figure 1.16).
3. On the Options bar, be sure the Chain check box is selected, as Figure 1.16 shows. This will allow you to draw the walls continuously.

4. The Draw panel has a series of sketch options. Because this specific wall is straight, make sure the Line button is selected, as shown in Figure 1.17.

Get used to studying the Ribbon and the Options bars—they will be your crutch as you start using Revit! Of course, at some point you need to begin placing items physically in the model. This is where the view window comes into play.
The View Window

To put it simply, “the big white area where the objects go” is the view window. As a result of your actions, this area will become populated with your model. Notice that the background is white—this is because the sheets you plot on are white. In Revit, what you see is what you get…literally. Line weights in Revit are driven by the object, not by the layer. In Revit, you aren't counting on color #5, which is blue, for example, to be a specific line width when you plot. You can immediately see the thickness that all your “lines” will be before you plot (see Figure 1.18). What a novel idea.

![Image of Revit interface](image)

**Figure 1.18:** The view window collects the results of your actions.

**WARNING** Metric users should not type in mm or other metric abbreviations when entering amounts suggested in the exercises. Revit will not accept such abbreviations. Simply enter the number provided within the parentheses.

To continue placing some walls in the model, keep going with the exercise. (If you haven’t been following along, you can start by clicking the Wall button on
the Architecture tab. In the Properties dialog box, select Exterior - Brick and CMU on MTL. Stud. Make sure the wall is justified to the finish face exterior.) You may now proceed:

1. With the Wall command still running and the correct wall type selected, position your cursor in a location similar to the illustration in Figure 1.19. Now pick a point in the view window.

2. With the first point picked, move your cursor to the left. Notice that two things happen: the wall seems to snap in a horizontal plane, and a blue dashed line apparently locks the horizontal position. In Revit, there is no Ortho. Revit aligns the typical compass increments to 0, 90, 180, 270, and 45 degrees.

3. Also notice the blue dimension extending from the first point to the last point. Although dimensions can't be typed over, this type of dimension is a temporary dimension for you to use as you place items. Type 100' (30000mm), and press the Enter key. (Notice that you didn't need to type the foot mark (') or mm. Revit thinks in terms of feet or millimeters. The wall is now 100' (30000mm) long (see Figure 1.19).

**Figure 1.19:** The procedure for drawing a wall in Revit Architecture
4. With the Wall command still running, move your cursor straight up from the endpoint of your 100'-long wall. Look at Figure 1.20.

![Figure 1.20](image)

**Figure 1.20**: How Revit Architecture works is evident in this procedure.

5. Type 80' (24000mm), and press Enter. You now have two walls.

6. Move your cursor to the right until you run into another blue alignment line. Notice that your temporary dimension says 100’–0” (30000.0). Revit understands symmetry. After you see this alignment line, and the temporary dimension says 100’–0” (30000.0), pick this point.

7. Move your cursor straight down, type 16' (4800mm), and press Enter.

8. Move your cursor to the right, type 16' (4800mm), and press Enter.

9. Press the Esc key twice.

Do your walls look like Figure 1.21? If not, try it again. You need to be comfortable with this procedure (as much as possible).

To get used to the Revit flow, always remember these three steps:

1. Start a command.

2. Focus on your options.

3. Move to the view window, and add the elements to the model.
Working with Revit starts with the ability to work with the view window and learning the quirks and feel of the interface.

If you start a command and then focus immediately on the view, you’ll be sitting there wondering what to do next. Don’t forget to check your Options bar and the appropriate Ribbon tab.

Let’s keep going and close this building by using a few familiar commands. If you’ve never drafted on a computer before, don’t worry. These commands are simple. The easiest but most important topic is simply how to select an object.

**Object Selection**

Revit has a few similarities to AutoCAD and MicroStation. One of those similarities is the ability to perform simple object selection and to execute common modify commands. For this example, you’ll mirror the two 16’–0” (4800mm) L-shaped walls to the bottom of the building:

1. Type **ZA** (zoom all).

2. Near the two 16’–0” (4800mm) L-shaped walls, pick (left-click) and hold down the left mouse button when the cursor is at a point to the right of the walls but above the long, 100’–0” (30000mm) horizontal wall.

3. You see a window start to form. Run that selection window down and to the left past the two walls. After you highlight the walls, as illustrated in Figure 1.22, let go of the mouse button, and you’ve selected the walls.

There are two ways to select an object: by using a crossing window or by using a box. Each approach plays an important role in how you select items in a model.
Crossing Windows

A crossing window is an object-selection method in which you select objects by placing a window that crosses through the objects. A crossing window will always start from the right and end to the left. When you place a crossing window, it’s represented by a dashed-line composition (as you saw in Figure 1.22).

Boxes

With a box object-selection method, you select only items that are 100 percent inside the window you place. This method is useful when you want to select specific items while passing through larger objects that you may not want in the selection set. A box always starts from the left and works to the right. The line type for a selection window is a continuous line (see Figure 1.23).

Now that you have experience selecting items, you can execute some basic modify commands. Let’s begin with mirroring, one of the most popular modify commands.

Modifying and Mirroring

Revit Architecture will allow you either to select the item first and then execute the command or to start the command and then select the objects to be modified. This is true for most action items and is certainly true for every command on the Modify toolbar. Try it:

1. Make sure only the two 16’–0” (4800mm) walls are selected.

2. When the walls are selected, you’ll see the Modify | Walls tab appear. On the Modify panel, click the Mirror – Draw Axis button, as shown in Figure 1.24.
3. Your cursor changes to a crosshair with the mirror icon, illustrating that you’re ready to draw a mirror plane.

4. Make sure the Copy check box is selected (see Figure 1.25).

5. Hover your cursor over the inside face of the 80’–0” (24000mm)-long vertical wall until you reach the midpoint. Revit will display a triangular icon, indicating that you’ve found the midpoint of the wall (see Figure 1.26).
6. When the triangular midpoint snap appears, pick this point. After you pick the point where the triangle appears, you can move your cursor directly to the right of the wall. You’ll see an alignment line appear, as illustrated in Figure 1.27. When it does, you can pick another point along the path. When you pick the second point, the walls are mirrored and joined with the south wall (see Figure 1.28).

Now that you have some experience mirroring items, it’s time to start adding components to your model by utilizing the items that you placed earlier. If you’re having trouble following the process, retry these first few procedures. Rome wasn’t built in a day. (Well, perhaps if they’d had Revit, it would have sped things up!) You want your first few walls to look like Figure 1.28.
Figure 1.27: Mirroring these walls involves: (1) picking the midpoint of the vertical wall, and (2) picking a horizontal point along the plane.

Figure 1.28: Your building should look like this illustration.
Building on Existing Geometry

Now that you have some geometry with which to work, and you have some objects placed in your model, Revit starts to come alive. The benefits of using Building Information Modeling (BIM) will become apparent quickly, as explained later in this chapter. For example, because Revit knows that walls are walls, you can add identical geometry to the model by simply selecting an item and telling Revit to create a similar item.

Suppose you want a radial wall of the same exact type as the other walls in the model. Perform the following steps:

1. Type ZA to zoom the entire screen.
2. Press the Esc key.
3. Select one of the walls in the model—it doesn’t matter which one.
4. Right-click the wall.
5. Select Create Similar, as shown in Figure 1.29.

**Figure 1.29**: You can select any item in Revit and create a similar object by right-clicking and selecting Create Similar.
**NOTE** When you right-click an item, you can choose to repeat the last command. You can now also select all items that are only in the current view.

6. On the Modify | Place Wall tab, click the Start-End-Radius Arc button, as shown in Figure 1.30.

![Figure 1.30](image)

**Figure 1.30**: Just because you started the command from the view window doesn’t mean that you don’t have to look at your options.

7. Again with the Options? Yes. Make sure Location Line is set to Finish Face: Exterior (it should be so already).

8. With the wheel button on your mouse, zoom into the upper corner of the building and select the top endpoint of the wall, as shown in Figure 1.31. The point you’re picking is the corner of the heavy lines. The topmost, thinner line represents a concrete belt course below. If you’re having trouble picking the correct point, don’t be afraid to zoom into the area by scrolling the mouse wheel.

9. Select the opposite, outside corner of the bottom wall. Again, to be more accurate, you’ll probably have to zoom in to each point as you’re making your picks.

10. Move your cursor to the right until you see the curved wall pause. You’ll also see an alignment line and possibly a tangent snap icon appear as well. Revit understands that you may want an arc tangent on the two lines you’ve already placed in your model.

11. When you see the tangent snap icon, choose the third point. Your walls should look like Figure 1.32.

Just because you’ve placed a wall in the model doesn’t mean the wall looks the way you would like it to appear. In Revit, you can do a lot with view control and how objects are displayed.
**Figure 1.31:** Select the top corner of the wall to start your new radial wall.

**Figure 1.32:** The completed exterior walls should look like this illustration.
View Control and Object Display

Although the earlier procedures are a nice way to add walls to a drawing, they don’t reflect the detail you’ll need to produce construction documents. The great thing about Revit, though, is that you’ve already done everything you need to do. You can now tell Revit to display the graphics the way you want to see them.

The View Control Bar

At the bottom of the view window, you’ll see a skinny toolbar (as illustrated in Figure 1.33). This is the View Control bar. It contains the functions outlined in the following list:

Scale  The first item on the View Control bar is the scale function. It gets small mention here, but it’s a huge deal. In Revit, you change the scale of a view by selecting this menu. Change the scale here, and Revit will scale annotations and symbols accordingly (see Figure 1.34).

Detail Level  The detail level allows you to view your model at different qualities. You have three levels to choose from: Coarse, Medium, and Fine (see Figure 1.35).

If you want more graphical information with this view, select Fine. To see how the view is adjusted using this control, follow these steps:

1. Click the detail level icon, and choose Fine.
2. Zoom in on a wall corner. Notice that the wall components are now showing in the view.

TIP  When you change the view control in a view, it isn’t a temporary display. You’re telling Revit how you want to plot this view. The view you see on the screen is the view you’ll see when it comes out of the plotter.

There are other items on the View Control bar, but we’ll discuss them when they become applicable to the exercises.
The scale menu allows you to change the scale of your view.

The detail level control allows you to set different view levels for the current view.

The View Tab

Because Revit is one big happy model, you'll quickly find that simply viewing the model is quite important. Within Revit, you can take advantage of some functionality in the Navigation bar. To activate the Navigation bar, first go to the View tab and click the User Interface button. Then go to the default 3D view, and make sure the Navigation bar is activated, as shown in Figure 1.36.

One item we need to look at on the Navigation bar is the steering wheel.
The View tab allows you to turn on and off the Navigation bar.

**Figure 1.36:** The View tab allows you to turn on and off the Navigation bar.

### The Steering Wheel

The steering wheel allows you to zoom, rewind, and pan. When you click the steering wheel icon, a larger control panel will appear in the view window. To choose one of the options, you simply pick (left-click) one of the options and hold down the mouse button as you execute the maneuver.

To use the steering wheel, follow along:

1. **Go back to Floor Plan Level 1, and pick the steering wheel icon from the Navigation bar, as shown in Figure 1.37.**

2. **When the steering wheel is in the view window (as illustrated in Figure 1.37), left-click and hold Zoom. You can now zoom in and out.**

**Figure 1.37:** You can use the steering wheel to navigate through a view.
3. Click and hold Rewind in the steering wheel. You can now find an older view, as shown in Figure 1.38.

![Rewind Tool](image)

**Figure 1.38:** Because Revit doesn’t include zoom commands in the Undo function, you can rewind to find previous views.

4. Do the same for Pan, which is also found on the outer ring of the steering wheel. After you click and hold Pan, you can navigate to other parts of the model.

Although you can do all of this with your wheel button, some users still prefer the icon method of panning and zooming. For those of you who prefer the icons, you’ll want to use the icons for the traditional zooms as well.

When you’re finished using the steering wheel, press Shift+W to close out.

**Traditional Zooms**

The next items on the Navigation bar are the good-old zoom controls. The abilities to zoom in, zoom out, and pan are all included in this function, as shown in Figure 1.39.

Of course, if you have a mouse with a wheel, you can zoom and pan by either holding down the wheel to pan or wheeling the button to scroll in and out.

![Zoom Controls](image)

**Figure 1.39:** The standard zoom commands
Thin Lines

Back on the View tab, you’ll see an icon called Thin Lines, as shown in Figure 1.40. Let’s talk about what this icon does.

![Thin Lines Icon](image)

**Figure 1.40**: Clicking the Thin Lines icon will allow you to operate on the finer items in a model.

In Revit Architecture, there are no layers. Line weights are controlled by the actual objects they represent. In the view window, you see these line weights. As mentioned before, what you see is what you get.

Sometimes, however, these line weights may be too thick for smaller-scale views. By clicking the Thin Lines icon, as shown in Figure 1.40, you can force the view to display only the thinnest lines possible and still see the objects.

To practice using the Thin Lines function, follow along:

1. Pick the Thin Lines icon.
2. Zoom in on the upper-right corner of the building.
3. Pick the Thin Lines icon again. This toggles the mode back and forth.
4. Notice that the lines are very heavy.

The line weight should concern you. As mentioned earlier, there are no layers in Revit Architecture. This topic is addressed in Chapter 13, “Creating Specific Views and Match Lines.”

3D View

The 3D View icon brings us to a new conversation. Complete the following steps, which will move us into the discussion of how a Revit model comes together!

1. Click the 3D View icon, as illustrated in Figure 1.41.
2. On the View Control bar, click the Visual Style button and choose Realistic, as illustrated in Figure 1.42.
3. Again on the View Control bar, select the Shadows On icon and turn on the shadows, as illustrated in Figure 1.43.

A word of caution: if you turn on shadows, do so with care. This could be the single worst item in Revit in terms of performance degradation. Your model will slow down with shadows on.

Within the 3D view is the ViewCube. It’s the cube in the upper-right corner of the view window. You can switch to different perspectives of the model by clicking the quadrants of the cube (see Figure 1.44).

*Figure 1.41:* The 3D View icon will be used heavily.

*Figure 1.42:* The Visual Style button enables you to view your model in color. This is typical for a 3D view.

*Figure 1.43:* Shadows create a nice effect, but at the expense of RAM.

*Figure 1.44:* The ViewCube lets you look freely at different sides of the building.
TIP The best way to navigate a 3D view is to press and hold the Shift key on the keyboard. As you’re holding the Shift key, press and hold the wheel on your mouse. Now move the mouse around. You’ll be able to view the model dynamically.

Your model should look similar to Figure 1.45.

![Figure 1.45: The model with shadows turned on](image)

**Lock It Up!**

If you are happy with this view and you don’t want to screw it up inadvertently, you can lock the orientation of the view as shown below. This is an important thing to know because, as you start creating sheets, you’ll sometimes find that the 3D view you’re randomly spinning around is actually on a sheet. For this lesson, leave the view unlocked.

Go back to the floor plan. Wait! How? This brings us to an important topic in Revit: the Project Browser.
The Project Browser

Revit is the frontrunner of BIM. BIM has swept our industry for many reasons. One of the biggest reasons is that you have a fully-integrated model right in front of you. That is, when you need to open a different floor plan, elevation, detail, drawing sheet, or 3D view, you can find it all right there in the model.

Also, this means your workflow will change drastically. When you think about all the external references and convoluted folder structures that make up a typical job, you can start to relate to the way Revit uses the Project Browser. Within Revit, you’re using the Project Browser instead of the folder structure previously used in CAD.

This approach changes the playing field. The process of closing the file you’re in and opening the files in which you need to do work is restructured in Revit to enable you to stay in the model. You never have to leave one file to open another. You also never need to rely on external referencing to complete a set of drawings. Revit and the Project Browser will put it all right in front of you.

To start using the Project Browser, follow along:

1. To the far left of the Revit interface is the Project Browser (see Figure 1.46).

![Image](image1.png)

**FIGURE 1.46**: The Project Browser is your new BIM Windows Explorer.

2. The Project Browser is broken down into categories. The first category is Views. The first View category is Floor Plans. In the Floor Plans category, double-click Level 1.
3. Double-click Level 2. Notice that the walls look different than in Level 1. Your display level is set to Coarse. This is because any change you make on the View Control bar is for that view only. When you went to Level 2 for the first time, the change to the display level had not yet been made.

4. In the view window, you see little icons that look like houses (see Figure 1.47). These are elevation markers. The elevation marker to the right might be in your building or overlapping one of the walls. If this is the case, you need to move it out of the way.

![Figure 1.47: Symbols for elevation markers in the plan. If you need to move them, you must do so by picking a window. There are two actual items in an elevation marker.]

5. Pick a box around the elevation marker. When both the small triangle and the small box are selected, move your mouse over the selected objects.

6. Your cursor turns into a move icon. Pick a point on the screen, and move the elevation marker out of the way.

7. In the Project Browser, find the Elevations (Building Elevation) category. Double-click South.

8. Also in the Project Browser, notice the 3D Views category. Expand the 3D Views category, and double-click the [3D] choice. This brings you back to the 3D view you were looking at before this exercise.

Now that you can navigate through the Project Browser, adding other components to the model will be much easier. You can now begin to add some windows.
**WARNING** “Hey! What happened to my elevation?” You’re in Revit now. Items such as elevation markers, section markers, and callouts are no longer just dumb blocks: they’re linked to the actual view they’re calling out. If you delete one of these markers, you’ll delete the view associated with it. If you and your design team have been working on that view, then you’ve lost that view. Also, you must move any item deliberately and with caution. This elevation marker you moved has two parts. The little triangle is actually the elevation. The little box is the part of the marker that records the sheet number on which the elevation will wind up. If you don’t move both items by placing a window around them, the elevation’s origin will remain in its original position. When this happens, your elevation will look like a section, and it will be hard to determine how the section occurred.

**Windows**

By clicking all these views, you’re simply opening a view (window) of the building, not another file that is stored somewhere. For some users, this can be confusing. (It was initially for me.)

When you click around and open views, they stay open. You can quickly open many views. There is a way to manage these views before they get out of hand.

In the upper-right corner of the Revit dialog, you’ll see the traditional close and minimize/maximize buttons for the application. Just below them are the traditional buttons for the files that are open, as shown in Figure 1.48. Click the X to close the current view.

![Figure 1.48](image-url)

**FIGURE 1.48:** You can close a view by clicking the X for the view. This doesn’t close Revit, or an actual file for that matter—it simply closes that view.
In this case, you have multiple views open. This situation (which is quite common) is best managed on the View tab. To utilize the Window menu, perform the following steps:

1. On the Window panel of the View tab, click the Switch Windows button, as shown in Figure 1.49.

2. After the menu is expanded, look at the open views.

3. Go to the [3D] view by selecting it from the Window menu and clicking the 3D icon at the top of the screen or by going to the [3D] view in the Project Browser.


5. In the Project Browser, open Level 1.

6. Go to the Windows panel, and select Tile Windows.

7. With the windows tiled, you can see the Level 1 floor plan along with the 3D view to the side. Select one of the walls in the Level 1 floor plan. Notice that it’s now selected in the 3D view to the side. The views you have open are mere representations of the model from that perspective. Each view of the model can have its own independent view settings.

8. Click into each view, and type ZA. Doing so zooms the extents of each window. This is a good habit to get into.

You’re at a good point now to save the file. This also brings us to a good point at which to discuss the different file types and their associations with the BIM model.
But I Used to Type My Commands!

You can still type your commands. In the Revit menus, you may have noticed that many of the menu items have a two- or three-letter abbreviation to the right. This is the keyboard shortcut associated with the command. You can make your own shortcuts, or you can modify existing keyboard shortcuts—if you navigate to the View tab. On the Windows panel, click the User Interface button. In the drop-down menu, click the Keyboard Shortcuts button. Here you can add or modify your keyboard shortcuts.

File Types and Families

Revit Architecture has a unique way of saving files and using different file types to build a BIM model. To learn how and why Revit has chosen these methods, follow along with these steps:

1. Click the save icon (see Figure 1.50).
2. In the Save As dialog, click the Options button in the lower-right corner (see Figure 1.51).

3. In the File Save Options dialog, you’ll see a place at the top where you can specify the number of backups, as shown in Figure 1.52. Set this value to 1.
Revit provides this option because, when you click the save icon, Revit duplicates the file. It adds a suffix of 0001 to the end of the file-name. Each time you click the save icon, Revit records this save and adds another file called 0002, leaving the 0001 file intact. The default is to do this three times before Revit starts replacing 0001, 0002, and 0003 with the three most current files.

4. Under the Preview section, you can specify in which view this file will be previewed. I like to keep it as the active view. That way I can get an idea of whether the file is up to date based on the state of the view. Click OK.

5. Create a folder somewhere, and save this file into the folder. The name of the file used as an example in the book is NER.rvt. (NER stands for “No Experience Required.”) Of course, you can name the file anything you wish, or you can even do your own project using the steps and examples from the book as guidelines.

Now that you have experience adding components to the model, it’s time to investigate exactly what you’re adding here. Each component is a member of what Revit calls a family.

**Understanding the Revit Architecture File (.rvt)**

The extension for a Revit Architecture file is .rvt. There are three separate Revit applications: Revit Architecture, Revit Structure, and Revit MEP. All three Revit applications share the same .rvt file extension. You can open a Revit file produced in any of these three applications directly. You don’t need object enablers to read items that don’t pertain to that discipline.

**System and Hosted Families (.rfa)**

As mentioned earlier, a Revit model is based on a compilation of items called families. There are two types of families: system families and hosted families. A system family can be found only within a Revit model and can’t be stored in a separate location. A hosted family is inserted similarly to a block (or cell) and is stored in an external directory. The file extension for a hosted family is .rfa.
System Families

System families are inherent to the current model and aren't inserted in the traditional sense. You can only modify a system family through its Element Properties within the model. The walls you've put in up to this point are system families, for example. You didn't have to insert a separate file in order to find the wall type. The system families in a Revit Architecture model are as follows:

- Walls
- Floors
- Roofs
- Ceilings
- Stairs
- Ramps
- Shafts
- Rooms
- Schedules/quantity takeoffs
- Text
- Dimensions
- Views

System families define your model. As you can see, the list pretty much covers most building elements. There are, however, many more components not included in this list. These items, which can be loaded into your model, are called hosted families.

Hosted Families

All other families in Revit are hosted in some way by a system family, a level, or a reference plane. For example, a wall sconce is a hosted family in that, when you insert it, it will be appended to a wall. Hosted families carry a file extension of .rfa. To insert a hosted family into a model, follow these steps:

1. Open the NER-01.rvt file or your own file.
2. Go to Level 1.
3. On the Architecture tab, select the Door button.
4. On the Modify | Place Door tab, click the Load Family button, as shown in Figure 1.53. This opens the Load Family dialog.
5. Browse to the Doors directory.

Note that, if you’re on a network, your directories may not be the same as in this book. Contact your CAD/BIM manager (or whoever loaded Revit onto your computer) to find out exactly where they may have mapped Revit.
6. Notice that there is a list of doors. Select Single-Raised Panel with Sidelights.rfa, and click Open.

7. In the Properties dialog, click the Type Selector, as shown in Figure 1.54. Notice that in addition to bringing in the raised panel door family, you also have seven different types of the same door. These types are simply variations of the same door. You no longer have to explode a block and modify it to fit in your wall.

8. Select Single-Flush 36” × 84” (914mm × 2134mm), as shown in Figure 1.54.

9. Zoom in on the upper-left corner of the building, as illustrated in Figure 1.55.

10. To insert the door into the model, you must place it in the wall. (Notice that before you hover your cursor over the actual wall, Revit won’t allow you to add it to the model, as shown in Figure 1.55.) When your pointer is directly on top of the wall, you see the outline of the door. Pick a point in the wall, and the door is inserted. (We’ll cover this in depth in the next chapter.)

11. Delete the door you just placed by selecting it and hitting the Delete key on your keyboard. This is just for practice for the next chapter.

You’ll be using this method of inserting a hosted family into a model quite a bit in this book and on a daily basis when you use Revit. Note that when a family is loaded into Revit Architecture, there is no live path back to the file that was loaded. After it’s added to the Revit model, it becomes part of that model. To view a list of the families within the Revit model, go to the Project Browser and look for the Families category. In the Families category, you’ll see a list of the families and their types, as Figure 1.56 shows.
Chapter 1 • The Autodesk Revit World

**Figure 1.54:** Each family .rfa file contains multiple types associated with that family.

**Figure 1.55:** Inserting a hosted family (.rfa)
The two main Revit files have been addressed. Two others are still crucial to the development of a Revit model.

**Using Revit Template Files (.rte)**

The .rte extension pertains to a Revit template file. Your company surely has developed a template for its own standards or will do so soon. An .rte file is simply the default template that has all of your company’s standards built into it. When you start a project, you’ll use this file. To see how an .rte file is used, follow these steps:

1. Click the Application menu button, and select New ➔ Project.
2. In the resulting dialog, shown in Figure 1.57, click the Browse button.

![Figure 1.57: A new Revit model is based on an .rte template file.](image)
3. Browsing throws you into a category with several other templates. You can now choose a different template.

4. Click Cancel twice.

Whenever you start a project, you’ll use the .rte template. When you start a new family, however, you’ll want to use an .rft file.

**Using Revit Family Files (.rft)**

The .rft extension is another type of template—only this one pertains to a family. It would be nice if Revit had every family fully developed to suit your needs. Alas, it doesn’t. You’ll have to develop your own families, starting with a family template. To see how to access a family template, perform these steps:

1. Click the Application menu button, and select New ➤ Family to open the browse dialog shown in Figure 1.58.

![Figure 1.58: The creation of a family starts with templates.](image)

2. Browse through these templates. You’ll most certainly use many of them.

3. Click the Cancel button.

Tempting? I know! We’ll cover creating families thoroughly in Chapter 17, “Creating Families.” As mentioned earlier, you’ll get to a certain point when you run out of Revit-provided content. If you’re feeling brave, go ahead and play around in one of the templates. You have nothing to lose (except time).
Are You Experienced?

Now You Can...

☑ Navigate the Revit Architecture interface, and start a model.
☑ Find commands on the Design bar, and understand how this controls your options.
☑ Find where to change a keyboard shortcut to make it similar to CAD.
☑ Navigate through the Project Browser.
☑ Understand how the Revit interface is broken down into views.
☑ Tell the difference between the two different types of families, and understand how to build a model using them.